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Introduction

Proloquo® is a multi-purpose, multilingual speech solution for Mac OS X that provides: (1) a 
full-fledged communication system (AAC) for people who cannot speak; (2) provides speech 
feedback in any application while typing for children and people with learning disabilities; (3) 
can serve as a talking word processor; (4) provides an advanced, multilingual speech engine 
for our KeyStrokes® on-screen keyboard and our SwitchXS® switch access solution.

Proloquo includes natural sounding Infovox iVox voices for a language of choice. The 
languages currently available include US English, UK English, German, Dutch, Flemish, 
Canadian French, American Spanish, Spanish, Italian, Polish, Swedish, Norwegian, 
,Portuguese and Brazilian Portuguese and others.  Infovox Vox voices for additional 
languages can be purchased as a language pack. Finally, Proloquo of course works with all the 
built-in voices of Mac OS X.

Proloquo is different from Apple’s excellent VoiceOver technology for Mac OS X Tiger 
in several ways. VoiceOver is a screen reader primarily intended for people who are blind. 
Proloquo, instead, is a multi-purpose speech solution that also includes certain features geared 
towards people with limited vision (such as the ability to speak what is below the cursor and 
to echo what the user types).
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1) Proloquo text window
2) Resizable and customizable toolbar
3) Resizable and customizable controller floating above all applications
4) Phrase windows containing user defined common phrases
5) Speech panel designed with LayoutKitchen

Proloquo can be used to create a complete personalized Augmentative and Alternative 
Communication (AAC) system using simple drag and drop (or copy and paste) of phrases into 
lists organized by topic. Additionally, with the included LayoutKitchen users can design their 
own speech panels for Proloquo with colorable and resizable buttons containing text and/or 
images in a variety of formats.
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QuickStart

Basic configuration of Proloquo is quite simple. You install it by dragging Proloquo from the 
disk image or CD to your hard disk. You double click the Proloquo application icon to load 
Proloquo. Next, a configuration wizard will appear that allows you to configure Proloquo for 
your most common use. If you want to use Proloquo for multiple purposes, you can at any 
time access the configuration wizard from the Proloquo menu to reconfigure Proloquo for 
another use.

If you already purchased Proloquo and have downloaded your selected Infovox iVox language 
or received it on the CD you should use the installer for your language to make the language 
available to Proloquo. It is recommended that after installation you restart your computer.

Main features

1.	Full-fledged communication system (AAC) for people who cannot speak

•	 Type text into Proloquo and let it speak (parts of) that text.

•	 Use drag and drop (or copy and paste) to create sets of custom words and phrases that 
are spoken with a simple mouse click or keystroke.

•	 Create textual speech panels for commonly used words and phrases.

•	 Use custom speech panels created with LayoutKitchen (included) which have colorable 
and resizable buttons containing text and/or images in a variety of formats.

•	 Optional: Use with custom image-based speech panels created with LayoutKitchen 
(purchase separately) using the over 8000 resizable, industry-standard Picture 
Communication Symbols™ from Mayer-Johnson (purchase separately).

2.  Speech feedback in any application while typing for children and people with learning 
disabilities

•	 Speaks text and other keystrokes typed in any application.

•	 Allows for customization of the pronunciation of individual letters, symbols and keys 
to give full control to speech language pathologists.

3.  Serves as a talking word processor

•	 Includes a basic text editor that can speak as the user types, but can also speak 
individual words, sentences and paragraphs.

•	 On Mac OS X Tiger, automatically synchronizes typed text and speech functions 
in applications such as TextEdit and Nisus Writer Express (that support Apple’s 
Accessibility API) as the user moves from window to window, effectively turning these 
two applications into talking word processors.
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•	 Allows the user to enter pronunciation exceptions.

4.  Provides an advanced, multilingual speech engine for KeyStrokes and SwitchXS

•	 Adds the capability to speak with high quality voices in various languages to the built-
in speech features of KeyStrokes and SwitchXS.

•	 Provides control over speech rate, pitch and exceptions.

•	 Allows the selection of different voices for communication, for the talking interface, 
and for speech cues.

System requirements

Proloquo 2.0 runs on Mac OS X 10.4 and higher. Proloquo requires a minimal screen 
resolution of 800 x 600 pixels. For optimum performance and access to all features Mac OS X 
10.5 or higher is recommended.
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Installation

Proloquo is distributed on a Disk Image (a file with the extension .dmg) or a CD-ROM. 
Proloquo can be installed by mounting the disk image or CD-ROM and dragging the Proloquo 
Application to your hard disk.

It is recommended that you install Proloquo in the Applications folder.

If you already purchased Proloquo and have downloaded your selected language or received 
it on the CD you should use the installer for your language to make the language available to 
Proloquo. Please restart your computer after installation.

Activating download copies

In case you have downloaded Proloquo from the Internet, the software will run in a full trial 
mode. Full trial mode expires after 15 days of use (these need not be consecutive). At that 
time Proloquo will revert to restricted trial mode in which you will no longer be able to save 
panels, preferences settings will no 
longer be saved, and the software 
will refuse to run for more than 10 
minutes at a time. You will need 
to activate Proloquo to lift these 
restrictions. If, after your 15-day full 
trial has expired, you still feel that 
you require more time to evaluate 
Proloquo, you can send an e-mail 
to <proloquo.trial@assistiveware.
com> to get an activation code that 
will allow you to extend your trial 
period for at least 7 consecutive 
days (counted from the moment 
your extended trial request is 
received). To lift all restrictions 
you should purchase a license of 
Proloquo to obtain a permanent 
activation code.

You should enter the activation code as well as your name, company name (if applicable), 
and e-mail address (if applicable) in the Activation window (select “Activation...” from the 
“Proloquo” menu) and press the Add License button.

Proloquo users who want to make speech panels with LayoutKitchen for use in Proloquo 
should also enter the Proloquo activation code in LayoutKitchen. To do this launch 
LayoutKitchen, go to the LayoutKitchenmenu, select “Activation...” and enter the activation 
code and other relevant details in the LayoutKitchenActivation window and press the Add 
license button.
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Activating CD-ROM copies

In case you obtained Proloquo on a CD-ROM, the application may have been pre-registered 
for you. In this case, when you first launch Proloquo, an Activation window will appear with 
your permanent activation code already pre-entered. Now you will only have to enter your 
name, company name (if applicable), and e-mail address (if applicable) in the Activation 
window and press the Add license button. Note that if the Activation window does not appear 
automatically, or a permanent activation code does not appear in the designated field, your 
copy may not have been pre-registered and you will have to enter the code you obtained from 
your reseller manually (it may have been written on the disk, the sleeve, a separate piece 
of paper or may have been sent to you by e-mail). In this case, follow the instructions for 
activating download copies.

If you do not activate your copy, Proloquo will run in full trial mode for 15 non-consecutive 
days and after that revert to restricted trial mode. To remove all limitations you should 
activate your copy by going to the Activation window (select “Activation...” from the 
“Proloquo” menu) and then follow the above instructions for activating download copies.

Please store your permanent activation code and user information in a safe place in case you 
need to re-install the software at some point.

Registration

After activating your copy you are kindly requested to register Proloquo online at http://www.
assistiveware.com/register.php so that we can keep you informed of updates and bug fixes. 
There are also a number of optional questions on this online form that help us to further 
improve Proloquo. The information supplied will be kept confidential.

http://www.assistiveware.com/cgi-bin/jump.cgi?link=http://www.assistiveware.com/register.php&src=PLman
http://www.assistiveware.com/cgi-bin/jump.cgi?link=http://www.assistiveware.com/register.php&src=PLman
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Getting started: The different ways to use Proloquo

Proloquo® is a multi-purpose speech solution so there are many different ways it can be 
used: (1) it is a full-fledged communication system (AAC) for people who cannot speak; 
(2) it provides speech feedback in any application while typing for children and people 
with learning disabilities; (3) it can 
serve as a talking word processor; 
(4) it provides an advanced, 
multilingual speech engine for our 
KeyStrokes® on-screen keyboard 
and our SwitchXS® switch access 
solution. To quickly switch between 
different kinds of uses or to configure 
Proloquo for the first time you 
can use the Configuration Wizard 
available in the Proloquo menu.

In this chapter each of the different ways to use proloquo is briefly discussed. Note that to 
prevent repetition some topics relevant to multiple uses are covered in great detail in one 
section and only touched upon in other sections. Thus to get a complete picture of what 
Proloquo can do for you it is recommended to read the whole manual.

Using Proloquo for Alternative and Augmentative Communication (AAC)

Out of the box Proloquo provides a communication solution for people who cannot speak 
but are able to read and write (using a hardware keyboard or an on-screen keyboard such as 
KeyStrokes and SwitchXS). For children or people who have difficulty with written language, 
speech panels for use with Proloquo can be designed in LayoutKitchen using colored buttons, 
photos, images, and symbols. In these cases it may be worthwhile to also purchase the Picture 
Communication Symbols developed by Mayer-Johnson, available from AssistiveWare as PCS 
for LayoutKitchen (over 8000 fully-resizable symbols).

You can use the configuration wizard (Proloquo menu) to configure Proloquo for 
communication. For greater control you can later adjust the details of the configuration in the 
preferences. For text based communication Proloquo offers two primary tools: (1) the text 
window and (2) the phrases windows.

The Proloquo text window can be used as a kind of draft 
pad in which you prepare text that you want to be spoken. 
You can either let Proloquo speak as you type (use the 
Typing preferences to control whether text is spoken by 
word, by sentence, etc.) or use the buttons in the Proloquo 
toolbar to speak the current word, sentence, paragraph or 
selection after you have fully composed the text you want 
to speak.

The phrases windows can be used to create complete sets 
of commonly used words and phrases. Utilise the Phrases 
menu to define different sets of phrases for use in different 
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contexts, for example school, home, office, leisure, and so forth. Within 
each set you can create a number of phrases files. Then at the bottom 
of the Phrases menu you can choose New Phrases Window, which will 
create a window showing the contents of one of the phrases files of the 
currently active set. A popup menu in the window will allow you to 
quickly go back and forth between different phrases files. You can create 
as many phrases windows as you want to have quick access to multiple 
phrases files at once, using the popup menu in each of them to select the 
phrases file to display in that particular window.

In the Phrases panel of the Proloquo preferences (use the Proloquo menu to access the 
preferences) you can determine whether phrases should be sorted alphabetically, by frequency 
of use or manually sorted. In those same preferences you can also determine what Proloquo 
should do when you click on a phrase: insert it for further editing in the text window, or speak 
it straight away. You can also trigger these actions by hitting the return key after selecting a 
phrase.

To add phrases you select the phrases file you want to modify from the popup menu in the 
phrases window. Next you can drag and drop text into the window. A single line of text will 
create a single new phrase. Multiple lines of text will create as many phrases as there are 
lines, making it easy to add multiple phrases at once. Instead of drag and drop you can also 
use copy and paste. To remove phrases you can select the phrases you want to remove and 
choose Clear from the Edit menu. You can also use Cut and Paste from the Edit menu to move 
phrases from one phrases window to another. Essentially, with the phrases windows you can 
easily create your own communication system and have quick access to your commonly used 
phrases at any time.

Finally, if you are working with SwitchXS or like to create speech panels for Proloquo you 
can use the Export as Proloquo or SwitchXS Panel command from the Phrases menu to create 
a simple speech panel based on the phrases 
you defined. You can either use the panel 
directly in Proloquo (speech panels are 
listed in the Panel menu), or you can further 
embellish the panel using LayoutKitchen.

Speech panels are a great way to have 
many common phrases just a click away. 
They can be purely text based, or, using 
LayoutKitchen, you can create panels 
with text, images, photos, and symbols. 
For details on using LayoutKitchen 
and the features it offers, please see the 
LayoutKitchen manual.

In LayoutKitchen, you can put photos on 
the buttons of a speech panel, or drag and 
drop your own drawings onto the buttons. 
However, you can also make use of the 
PCS for LayoutKitchen image collection 
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that was mentioned earlier. It is very easy to quickly create a speech panel in LayoutKitchen 
with the over 8000 industry-standard picture communication symbols of that collection. Do 
note that there are some restrictions on sharing panels with the PCS symbols as these are 
copyrighted by Mayer-Johnson. For more information see the documentation of the PCS for 
LayoutKitchen collection. In LayoutKitchen, you can also make buttons that load another 
panel, or that instead of speaking, type text into the Proloquo text window.

How switch users can use Proloquo as an AAC solution is explained in the section on Using 
Proloquo with KeyStrokes and SwitchXS.

Using Proloquo for speech feedback while typing in any application

You can use the configuration wizard (Proloquo menu) to configure Proloquo as a support 
for children and people with learning disabilities. For greater control you can later adjust the 
details of the configuration in the preferences.

Proloquo can speak text and other keystrokes as you type into any application, providing 
immediate feedback on the keys and words typed so that the user can hear spelling or other 
errors. This kind of spoken feedback is often much easier than reading back a written text. 
You can control the details of what is spoken in the Typing panel of the Proloquo preferences. 
Note that to enable speaking as you type Echo Typing must be turned on as well as Recording. 
Echo Typing takes care of speaking what you type inside the Proloquo text window and, only 
if Recording is also on, of speaking text typed into any other applications. At any time you 
can turn these features on or off using the Controller, the text window toolbar, or the Speech 
menu.

Note that while Proloquo makes an effort to keep what you type synchronized with its 
internal text buffer (visible at any time in the Proloquo text window) it cannot do so under 
all circumstances. If what you hear does not sound right, just use the Clear button in the 
Controller to start from a clean slate. For some applications, namely those that support 
Apple’s Accessibility API, Proloquo is able to do a much better job in keeping things 
synchronized, especially when you work in Mac OS X Tiger. These include Apple’s TextEdit 
and iChat and Nisus Writer Express. To make use of this improved synchronization, turn on 
the two checkboxes at the 
bottom of the Typing panel 
of the Proloquo preferences. 
For more information see the 
Preferences chapter in this 
manual.

To later listen back to what 
was written you can select 
the text in the application you 
are working in and use the 
Load Selection function in the 
Controller to load the text into 
the Proloquo text window. 
You may subsequently use the 
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Speak Word, Speak Sentence and other speech buttons to listen back to the text step by step.

You can customize the pronunciation of individual letters, special symbols, and keys using 
the Keys & Character Pronunciation command from the Edit menu. The Keys and Character 
window contains a number of predefined lists for several common languages that can be used 
as a starting point. If you want to make customizations you select one of the existing lists 
and then choose Save List As… from the popup menu and give your new list a name. You 
can then edit that list, deleting items you do not want and adding others. The Pronunciation 
defined in this window is used each 
time a single letter needs to be 
spoken or a single key is used. To 
let Proloquo speak individual letters 
and keys you need to turn on the 
appropriate checkboxes in the Typing 
panel of the Proloquo preferences. 
This tool can be very helpful for 
speech therapists. If you need more 
control than just transcribing the way 
you want something to be spoken, 
please contact us for the technical 
documentation for your language that 
provides details on how to enter items 
with phonetic codes.

Using Proloquo as a talking word processor

You can use the configuration wizard (Proloquo menu) to configure Proloquo as a talking 
word processor. As always, for greater control you can later adjust the details of the 
configuration in the preferences.

Proloquo includes a basic text editor that can open and save Rich Text Files (RTF). These 
can also be opened and saved in applications such as Word and TextEdit as well as in most 
other modern word processors. When you type directly into the Proloquo text window you 
will never have any of the synchronization issues discussed in the previous section. However, 
you will not have all the advanced word processing features found in applications such as 
Word, TextEdit, Pages, or Nisus Writer Express. You could always write your text in Proloquo 
and later embellish it with different fonts and styles in another application. The Proloquo text 
editor does allow you to change the font and text size for the entire text at once, using the 
Font Window from the Format menu. It also allows undo, cut, copy, and paste.

The Proloquo text editor also has a number of special features. It can speak while you 
are typing, a feature already discussed in the previous section. It can speak the current 
word, the current sentence, the current paragraph, the whole text and a part of the text 
(either the selection or the part starting at the text cursor). Of course you can also turn 
speech off or pause it. Note that when you use, for example, the Speak Word command, 
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Proloquo will not only speak the next word, but also move the cursor to the next word. This 
way you can go through the text word by word or sentence by sentence.

Whether typing is “recorded” from other applications is determined by the Recording button 
and whether typing is echoed as you type is determined by the Echo Typing button. Note 
that at any time you can use the Hot key & Toolbar Configuration panel of the Proloquo 
preferences to determine which buttons are available in the text window toolbar and even 
change their names or assign keyboard shortcuts to them. When using Proloquo as a talking 
word processor you can either have it speak as you type or type silently and then let is speak 
once you are done. Or, of course, you can do both.

Proloquo can turn another word processor into a talking word processor, especially 
those word processors that implement Apple’s Accessibility API. However, even some of 
Apple’s own applications do not fully support this API at present. This includes the iWork 
applications: Pages and Keynote. Also Microsoft Word does not currently support it. 
However, Apple’s TextEdit supports it extremely well and so does Nisus Writer Express. 
When you use one of the latter two applications and have Proloquo configured for use as a 
talking word processor (and running the background), you cannot only hear what you are 
typing with the high quality voices provided with Proloquo, but you can also use Proloquo’s 
Speak Word, Speak Sentence functions and so forth with the text cursor being updated to the 
new position in TextEdit. All of this works best in Mac OS X 10.4. You should make sure that 
“Enable access for assistive devices” is turned on in the Universal Access system preferences 
of Mac OS X as well as the two checkboxes at the bottom of the Typing panel of the Proloquo 
preferences. Under those conditions Proloquo should be able to keep track of your typing, 
also when you work in multiple windows and move back and forth between different pieces 
of text.

You can create pronunciation exceptions if you feel that Proloquo does not pronounce 
certain words correctly. Typically, which words are not pronounced correctly varies from 
voice to voice and, of course, from language to language. So Proloquo allows you to create 
multiple lists of exceptions.

You access the Pronunciation Exceptions through the Edit menu. In the Exceptions window 
you then define a Find and a Replace text. When Proloquo is speaking it will replace the 
Find text with the Replace text. You can use the Test Exception button to listen to your 
Replace text and make sure it 
sounds right to you. Note that 
whenever you make changes to 
an exception you should press 
the Apply button to confirm 
the changes. If you need more 
control than just transcribing 
the way you want something 
to be spoken, please contact us 
for the technical documentation 
for your language that provides 
details on how to enter items 
with phonetic codes.
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Using Proloquo with KeyStrokes and SwitchXS

You can use the configuration wizard (Proloquo menu) to configure Proloquo as a speech 
engine for either KeyStrokes or SwitchXS. For more control you can later adjust the details of 
the configuration in the preferences.

Proloquo includes high quality Infovox iVox voices in a language of choice. You receive 
these voices when you purchase Proloquo. They are among the very best in the industry and 
are very natural sounding. To get an idea of how they sound before you make a purchase you 
can listen to short samples at http://www.assistiveware.com/proloquo.php. Additional voices 
for her languages can be purchased. 

Proloquo adds high quality voices to KeyStrokes and SwitchXS and enables voice 
output in other languages than the built-in English Mac OS X voices. Both KeyStrokes and 
SwitchXS have basic speech features that use the built-in Mac OS X voices. As soon as you 
run Proloquo in the background KeyStrokes and SwitchXS will channel all their voice output 
through Proloquo.

Proloquo allows the selection of different voices for communication, for the talking 
interface, and for speech cues. These features are exploited by both KeyStrokes and 
SwitchXS so that you can distinguish text messages and keys typed from speech cues. In 
addition, if you are making use of the Talking Interface features of Proloquo, a third voice can 
be set for that feature.

KeyStrokes offers several speech features, all located in the Audio & Visual Feedback panel 
of the KeyStrokes preferences. When Proloquo is running in the background the speech 
features in that panel are powered by Proloquo. The “Speak the key or suggestion below the 
cursor” feature in that panel uses the Proloquo Cue Voice as selected in the Voice panel of the 
Proloquo preferences. The other KeyStrokes speech features use the  Communication Voice 
as selected in the Voice panel of the Proloquo preferences. If you do not want to hear the 
same text being spoken twice you should not enable “Speak keys as you type” and “Speak 
completed text” in KeyStrokes and at the same time turn on the Echo Typing features in 
Proloquo. You should either 
let Proloquo handle the 
speaking as you type, or let 
KeyStrokes handle it. Unless 
you want to hear each letter 
as it is typed, it is probably 
best not to use Echo Typing 
in Proloquo but rely on the 
“Speak keys as you type” and 
“Speak completed text” of 
KeyStrokes. This is especially 
true if you like to use 
shortcuts in KeyStrokes that 
are automatically expanded as 
you type. Of course, feel free 
to experiment and see what 
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works best for you.

SwitchXS offers two kinds of speech features. The first one is the ability to turn on voice 
cueing in  the Audio & Speech panel of the SwitchXS settings. When Proloquo is running in 
the background, the voice you have selected as Cue Voice in the Voice panel of the Proloquo 
preferences will be used. To allow voice feedback with higher scan speeds it is recommended 
that you set the Speed of the Cue Voice higher than its default setting, otherwise the voice 
cueing will loose synchronization with the scanning process in SwitchXS. The other speech 
feature SwitchXS provides is the ability to speak the text of message buttons in scan panels 
created with LayoutKitchen. If you combine this feature with Proloquo, you effectively have a 
switch-based communication system that provides high quality natural sounding voice output.

Proloquo also offers control over voice speed, pitch, and exceptions. Neither KeyStrokes 
nor SwitchXS offers that kind of control. In the Voice panel of the Proloquo preferences 
you can set the volume, speed (sometimes also referred to as rate), and pitch separately for 
each of the three voices. Note that while the Acapela and Apple voices allow changing the 
pitch, the Cepstral voices currently do not respond to changes in the pitch setting. On how to 
create pronunciation exceptions please see the section on using Proloquo as a talking word 
processor.

Support for people with visual impairments

Proloquo can be of help for people with low vision. However, for people who are blind it is 
not the right solution. If you are blind you should consider Apple’s VoiceOver, which comes 
standard with Mac OS X 10.4 and later. For people with limited vision Proloquo can offer 
quite a bit of support, but our VisioVoice software would generally be more appropriate.

Proloquo can speak the titles of many screen objects such as buttons, menus, finder items 
and text below the cursor in most applications. You can control the details of what is spoken 
in the Talking Interface panel of the Proloquo preferences. You can control what kind of items 
are spoken, how long the cursor must be over an item before it is spoken, and more. If you do 
not need this kind of speech feedback all the time, you can set an option in those preferences 
that Proloquo only speaks 
interface elements when, for 
example, the control key is 
pressed. To use the Proloquo 
Talking Interface features 
“Enable access for assistive 
devices” need to be turned 
on in the Universal Access 
system preferences of Mac 
OS X. 

Proloquo also provides 
visual aids within Proloquo 
itself to aid people with 
low vision. For example, 
unlike the toolbars in most 
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applications the Proloquo toolbars are fully resizable and if made larger can display very large 
high quality icons. The toolbar of the Proloquo text window can be resized by dragging the 
central splitter down or up. The Controller window can be resized and reshaped by dragging 
its size box in the lower right corner. The text in the Proloquo text window and in the phrase 
windows can be increased in size as well. Use the Show Fonts command in the Format menu 
to choose a different and/or larger font.

Finally, you can select different voices for the different speech features of Proloquo. You 
can for example select a communication voice that is used to echo text that you type or text 
that you ask Proloquo to speak and select an interface voice that will be used when Proloquo 
speaks the titles or text of interface elements.

Listening to text with Proloquo

Proloquo can speak any selected text in any application that supports the clipboard (i.e. 
provides a Copy command in its Edit menu). There are two ways in which you can trigger 
this function: (1) you can use the Load Selection button in the Controller; (2) you can use a 
keyboard shortcut for this function. In the Power Options panel of the Proloquo preferences 
you can determine whether Proloquo should automatically clear any previous text in its text 
window when Load Selection is invoked and whether Proloquo should start speaking the text 
immediately.

Keyboard shortcuts for Proloquo’s speech functions are defined in the Hot key & Toolbar 
Configuration panel of the Proloquo preferences. On the left of that panel you can enter a 
hot key in the Hot Key column. Hot Keys can either function as simple keyboard shortcuts 
that are only active in Proloquo or as global hot keys that work in any application. If you 
want a hot key to work in all applications, turn on the checkbox in the Global column. For 
more information on what you can do in the Hot key and Toolbar Configuration panel see the 
chapter on Preferences in this manual.

While the Load Selection function discussed above works only for text that is selectable, 
the Talking Interface features mentioned earlier can be used to speak also non-editable and 
non-selectable text in many 
applications. This relies on 
Apple’s Accessibility API 
so it will not work in every 
application and may not work 
for every single piece of text 
in a particular application. It 
works well in, for example, 
TextEdit, iChat, and Safari 
as well as in many other 
applications.  It also works 
for most dialog messages. 
Note that Microsoft Word 
does not currently provide 
the necessary support for its 
editor windows.
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In the Talking Interface panel of the Proloquo preferences you can set the Talking Interface 
feature to only speak text and no other interface elements; you can also turn off the “Say 
interface element type” option. That way it will purely function for text. If you do not want 
to hear every piece of text that you hold the cursor above, you can turn on one or more of 
the checkboxes for the modifier keys so that Proloquo will, for example, only speak text 
below the cursor when you hold down the command key. Note that you do not need to click 
on the text. Just holding the cursor above it for the duration you have set in the Talking 
Interface panel is enough. Note that Mac OS X offers a similar feature in the Speech system 
preferences, but it gives you less control and does not use the high quality voices included 
with Proloquo.

Proloquo can pause between sentences when reading text. This feature makes it far 
easier to understand the text you are listening to. In the Power Options panel of the Proloquo 
preferences you can set the pause between sentences anywhere between 0 and 4 seconds. 
When you use the Load Selection feature or when you have text in the Proloquo text window 
and choose Speak Paragraph or Speak All, Proloquo will pause between sentences for the 
duration you have set.

Creating audio files and iTunes tracks from speech

Proloquo can save speech to an audio file or iTunes track. Note that the license for the 
Infovox iVox voices does not permit commercial use or distribution of such audio files; only 
personal use is allowed.

The “Speech to Audio File” and “Speech to iTunes Track” commands are available from the 
File menu and speak the contents of the Proloquo text window to an audio file. So you first 
need to paste the text you want to convert to audio into the Proloquo text window or open an 
rtf file using the Open command in the File menu. When you choose “Speech to Audio File” 
a save dialog will allow you to choose a location and name for your audio file. Audio files 
are always saved as uncompressed AIFF files; you can use QuickTime Pro, iTunes or other 
utilities to convert such audio files to other formats.

If you just want to get the audio into iTunes, for example, to load it onto your iPod it is more 
practical to use the “Speech to iTunes Track” command. This will allow you to pick a track 
name and a playlist to put the track into (if the playlist does not exist it will automatically 
be created for you). Once the audio is generated Proloquo will instruct iTunes to import the 
track. If you do not want iTunes to 
start playing your new track after 
importing uncheck the “Play songs 
while importing” checkbox. Audio 
tracks generated by Proloquo will 
be set to Genre “Books & Spoken” 
with artist set to “Proloquo” so 
that they are easy to locate in your 
library. Once the track is in iTunes 
you can copy it to your iPod in the 
same way as music tracks.
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Saving speech to audio may take quite some time if it is a long text. Depending on the speed 
of your computer it can be anywhere between 5 times as fast as normal speech to 50 times as 
fast. But, even at 50 times normal speech, a 12-page document that results in a 60 minutes 
audio file may take over a minute to generate. On a slower computer it may take several 
minutes.
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Preference settings

Accessing the preferences

The Proloquo Preferences can be accessed through the Preferences command from the 
“Proloquo” menu. 

In most cases the default preference settings will be fine, but once you gain more experience 
with Proloquo, you will appreciate the ability to fine-tune Proloquo’ powerful features to your 
specific needs or preferences.

General preferences

Automatically launch Proloquo after login. Use this option if you want to use Proloquo each 
and every day and like it to 
automatically load after you 
login to your machine.

Ask to save changes in the 
Proloquo window before 
quitting. This option is useful 
if you do not use the Proloquo 
text window as a scratch 
pad that you want discarded 
as you quit, but use the text 
window as a talking word 
processor and want Proloquo 
to remind you to save it 
before quitting.

Alarm sound. Use this menu 
choose the sound that should be used when you push the Alarm button. Sounding the default 
Alarm sound is a great way to get help quickly.

Keyboard layout. For languages using the Roman alphabet you should set this to Automatic. 
For some other languages such as, for example, Russian you should to set this to the keyboard 
layout you use to type in that language. This will ensure that when Proloquo records typing in 
other applications it will know what keys generate what letters.

Voice preferences

Communication voice. This is the voice that is used when you have echo typing turned on and 
when you use buttons on speech panels or make use of the Speak Word, Speak Sentence, and 
other Speak functions.

Interface voice. This voice is used for the Talking Interface features of Proloquo.

Cue voice. This voice is used for the speech cueing features found in KeyStrokes and 
SwitchXS.
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Volume. Use the volume 
sliders to change the volume 
used for each of the voices.

Pitch. Use the pitch sliders to 
change the pitch used for each 
of the voices. Note that the 
pitch is currently expressed 
as a percentage deviation 
from the default pitch. Also 
note that Cepstral voices do 
not currently support pitch 
changes.

Speed. Use the speed sliders 
to change the speed used for 
each of the voices. Note that 
the speed is currently expressed as a percentage deviation from the default speed.

Note that the most recently used communication and interface voices are available in the 
Voice menu for quick access at any time without having to go in to the Preferences.

Typing preferences

Type sound. Choose a type sound if you want to hear a sound each time you press a key.

Speak non-letter keys. Use this option if you also want speech feedback when you press for 
example the return or shift key.

Speak letter by letter. This will speak each single letter as you type. This function can be very 
helpful for slow typers, but should probably be off for people who type faster than Proloquo 
can speak.

Speak word by word. Select 
this option if you want each 
word to be spoken as you 
write.

Speak sentence by sentence. 
Use if you want each sentence 
be spoken as soon as it is 
completed.

Speak paragraph by 
paragraph. This will speak 
the whole paragraph after you 
type a return. In iChat it will 
thus speak each time you hit 
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return to send your message to your iChat buddy.

Also record typing inside Proloquo. Except for users with low vision, this should probably be 
turned off. If it is on it will also record typing into the Proloquo text window when you type 
text in one of the other Proloquo windows or dialogs.

Clear or refresh text on application switch. Use this if you want Proloquo to try to keep its 
text buffer (as shown in the Proloquo text window) synchronized as you go from working in 
one application to working in another. Note that it is recommended that “Enable access for 
assistive devices” is turned on the Universal Access system preferences. This function works 
best on Mac OS X 10.4 and higher.

Clear or refresh text on clicks. Use this if you want Proloquo to try to keep its text buffer (as 
shown in the Proloquo text window) synchronized as you move back and forth working in 
different windows. Note that “Enable access for assistive devices” should be turned on the 
Universal Access system preferences. This function works best on Mac OS X 10.4 and higher. 
Also note, that it will not work well for all applications.

Talking Interface preferences

Note that all the features in the Talking Interface panel require “Enable access for assistive 
devices” to be turned on in the Universal Access system preferences. Also note that this 
feature only works for those interface elements for which applications support Apple’s 
Accessibility API.  In some applications it will work for all elements and in others only for 
specific ones. It works very well in, for example, Apple’s Safari, TextEdit, and iChat.

Talking interface. Use this check box to turn on or off all talking interface features at once.

Speak buttons below the cursor. Check this box if you want buttons below the cursor to be 
spoken.

Speak text below the cursor. 
Check this box if you want 
text below the cursor to be 
spoken. This includes editable 
text such as found in a text 
or word processor document 
window or in an entry field 
of a dialog. It also includes 
non-editable text found in, for 
example, message dialogs.

Speak menus and menu items 
below the cursor. Check this 
box if you want menu titles 
and menu item titles below 
the cursor to be spoken.
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Speak Finder items below the cursor. Check this box if you want Finder items, such as 
application and document icons, below the cursor to be spoken.

Say interface element type. Use this if you want Proloquo to not just say the title of a button or 
menu item, but also that it is a button or menu item.

Only speak when modifier key(s) are held down. Check one or more of the modifier keys if 
you only want Proloquo to speak the item below the cursor when the selected modifier keys 
are held down at the same time. Use this option if you only want to hear what is below the 
cursor occasionally rather than all the time.

Delay before speaking. Set the delay that Proloquo should respect before speaking an 
interface element, so that it will only speak items that you really pause above.

Phrases preferences

Sort phrases. Select the sorting order Proloquo should apply to all phrases windows. If you 
select “Manual sort” you will be able to control sorting for each phrases file separately using 
the menu commands in the Phrases menu.

Speak phrase on. Select the 
action you would like to use 
as a way to tell Proloquo that 
it should speak a phrase in 
the Phrases window. Choose 
between Click, Double Click, 
and Option-click.

Insert phrase in Proloquo 
window on. Select the action 
you would like to use as a 
way to tell Proloquo that 
it should insert the clicked 
phrase in the Proloquo text 
window. Choose between 
Click, Double Click, and 
Option-click.

Immediately speak the selected phrase. Use this if you want to speak selected phrases in the 
active Phrases window when you hit the return key.

Insert the selected phrase into the Proloquo window. Use this if you want the selected phrases 
in the active Phrases window  to be inserted in the Proloquo text window when you hit the 
return key.

Power Options preferences

Automatically clear any previous text. This option applies to the Load Selection command and 
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if you turn it on will erase any 
current text in the Proloquo 
text window when you issue 
the Load Selection command.

Automatically start speaking. 
This option applies to the 
Load Selection command 
and if turned on will 
automatically start speaking 
when you issue the Load 
Selection command.

Speak new text after previous 
text is finished. This applies to 
the Communication voice. If 
turned on this will ensure that 
Proloquo queues up the text that you ask it to speak through the various Speak commands, so 
that you will hear them one after another.

Immediately speak new text. This applies to the Communication voice and if turned on will 
force Proloquo to break off any on-going speech and to immediately start speaking the new 
text.

Pause between sentences. You can use this slider to set a pause between sentences when using 
the Speak Paragraph or Speak all command. It also applies to the Load Selection command if 
the selection contains multiple sentences.

Hot key & Toolbar Configuration

This preference panel consists of a table showing all the Proloquo functions that can be shown 
in the Proloquo text window toolbar and or in the Controller window. It is a rather large table. 
To see all the columns, you will have to scroll the table horizontally.

For each function you can 
set a hot key to trigger the 
function from the keyboard. 
If you also check the global 
check box for that function, 
the hot key will work from 
within any application. If you 
check the global checkbox, 
make sure you do not assign 
keys that are commonly used 
by other applications or the 
system, as that may lead to 
conflicts with multiple actions 
happening at the same time.
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The third column shows the function and is not editable. The Controller and Proloquo column 
allow you to chose in which toolbars the function should appear. A few functions are only 
available for the Proloquo text window or only for the Controller.

The final two columns allow you to modify the labels of the buttons. Some buttons have two 
states (on and off). Therefore, Proloquo allows you to edit both labels for those functions. 
Editing the labels allows you to make the Proloquo toolbars easier to use for someone who 
does not speak English and would like to see the button labels in his or her own language. 
Proloquo is currently localized in English, French, and German. For other languages you 
should translate the button labels yourself.
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Tips and Tricks

This section describes a few tips and tricks when using Proloquo.

Showing only text or only icons in the toolbars

You can control-click (or right-click if you have a two button mouse) on the toolbar in the 
Proloquo text window or the Controller window to access a contextual menu. This menu will 
allow you to display the commands in the toolbar as labels, as icons, or as both.

Using one speech panel for both Proloquo and SwitchXS

The panel file format for SwitchXS and Proloquo is identical. Therefore, it is easy to use 
LayoutKitchen to create a panel once and save it both for SwitchXS (in the SwitchXS Scan 
Panels folder of the AssistiveWare Support folder) and Proloquo (in the Speech Panels folder 
of the AssistiveWare Support folder) from LayoutKitchen. Proloquo will simply ignore those 
buttons it cannot handle (such as key and mouse buttons). Obviously, this is mainly useful 
for communication panels that you want to design once, and then let switch users use through 
SwitchXS and mouse users through Proloquo.

Working with multiple languages

The Voice menu allows you to quickly switch between the five most recently used 
communication and interface voices. If you prefer to use the keyboard to switch voices you 
can use the command key shortcuts listed in that menu. The menu also allows you quick 
access to the Voice preferences panel of Proloquo if you want to pick a voice not listed in the 
menu.
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Known issues

Font Window limitations

The Font window accessible through the Format menu offers a number of buttons and other 
controls that cannot be used in Proloquo. For technical reasons it is not possible to disable 
those functions. Please use the Font window only to change the font and text size. This can be 
done for the Proloquo text window and for the Phrases windows.

Compatibility with Apple’s Mail on Mac OS X 10.4 (Tiger)

Apple changed Mail in 10.4 (Tiger) in such a way that Proloquo cannot currently work as 
well with the New Message window in Mail as it could on 10.3. On Mac OS X 10.3 (Panther) 
Mail did conform to Apple’s Accessibility API  more strictly, making it work well together 
with Proloquo’s Talking Interface and typing features. The primary issue in Tiger is Mail’s 
New Message window that reports its context as non-editable text instead of as editable text 
to Proloquo. However, the basic features such as the recording and echoing of text typed still 
work. If text and speech loose synchronization just use the Clear function in Proloquo. Then 
continue typing.

Compatibility with iWork

It is recommended to use Proloquo with iWork 2008. Earlier versions of both Keynote and 
Pages do not fully support Apple’s Accessibility API in key areas such as the text area in the 
Pages document window. This makes these older versions less ideal for Proloquo. However, 
the basic features such as the recording and echoing of text typed still work. If text and speech 
loose synchronization just use the Clear function in Proloquo. Then continue typing.

Compatibility with Microsoft Office 2004 and 2008

Neither Word nor Excel currently support Apple’s Accessibility API. This means that it is 
difficult for Proloquo to maintain synchronization with the text the user is typing and will 
occasionally require you to Clear the Proloquo text window. However, the basic features such 
as the recording and echoing of text typed still work. If text and speech loose synchronization, 
just use the Clear function in Proloquo. Then continue typing. Also, you may want to consider 
Nisus Writer Express as an alternative to Word. Nisus Writer Express does fully support 
Apple’s Accessibility API, making it a perfect partner for Proloquo.

Compatibility with third part voices

Proloquo works with any Speech Manager compliant voices. Do note that some voices do not 
respond to changes in the pitch setting.
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Support

Support steps

Step 1. Check this manual and/or consult the Proloquo help function. This help func-
tion can be accessed through the “Help” menu when Proloquo is the active 
(front-most) application.

Step 2. Consult the dealer where you purchased Proloquo.

Step 3. Contact your local distributor (see below for details).

Step 4. If none of the above help or if you purchased directly with AssistiveWare, 
send an email to Proloquo@assistiveware.com

Local distributors

Please find below a list of the current local distributors. Note that this may change over 
time and that the latest information on local distributors is always available at http://www.
assistiveware.com/resellers.php

Territory Distributor / Dealer Purchase online

North America 
(USA, Canada, 
Mexico & 
Caribbean)

Origin Instruments Corporation 
(full support) 
854 Greenview Drive 
Grand Prairie 
Texas 75050-2438 
USA 
Phone: 972-606-8740 
FAX: 972-606-8741 
Email: support@orin.com 
Web: http://orin.com/access/proloquo/

Origin Instruments Corporation 
(full support) 
http://orin.com/ec/proloquo/

Everywhere else AssistiveWare 
(email only support in English, French or 
Dutch) 
Van Speijkstraat 73-D 
1057 GN Amsterdam 
The Netherlands 
Europe 
FAX: +31-20-6128266 
Email: Proloquo@assistiveware.com 
Web: http://www.assistiveware.com

AssistiveWare 
(email only support in English, French or 
Dutch) 
http://www.assistiveware.com/purchase.
php

http://www.assistiveware.com/cgi-bin/jump.cgi?link=http://www.assistiveware.com/resellers.php&src=PLman
http://www.assistiveware.com/cgi-bin/jump.cgi?link=http://www.assistiveware.com/resellers.php&src=PLman
mailto:support@orin.com
http://www.assistiveware.com/cgi-bin/jump.cgi?link=http://orin.com/access/proloquo/&src=PLman
http://www.assistiveware.com/cgi-bin/jump.cgi?link=http://orin.com/ec/proloquo/&src=PLman
http://www.assistiveware.com/cgi-bin/jump.cgi?link=http://www.assistiveware.com&src=XS15man
http://www.assistiveware.com/cgi-bin/jump.cgi?link=http://www.assistiveware.com/purchase.php&src=PLman
http://www.assistiveware.com/cgi-bin/jump.cgi?link=http://www.assistiveware.com/purchase.php&src=PLman
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Software License Agreement

AssistiveWare / Niemeijer Consult 
Software License Agreement 
Single Use License

PLEASE READ THIS SOFTWARE LICENSE AGREEMENT (“LICENSE”) CAREFULLY BEFORE USING THE 
SOFTWARE. BY USING THE SOFTWARE YOU ARE AGREEING TO BE BOUND BY THE TERMS OF THIS 
LICENSE. IF YOU DO NOT AGREE TO THE TERMS OF THIS LICENSE (IF APPLICABLE) RETURN THE 
NIEMEIJER CONSULT SOFTWARE TO THE DEALER WHERE YOU OBTAINED IT. DEPENDING ON THE TERMS 
OF DELIVERY OF YOUR DEALER YOU ARE ELIGIBLE FOR A (PARTIAL) REFUND.

1. General. The Software and documentation accompanying this License whether on disk, in read only memory, on any other 
media or in any other form (henceforth referred to collectively as the “Software”) are licensed, not sold, to you by Niemeijer 
Consult for use only under the terms of this License, and Niemeijer Consult reserves all rights not expressly granted to you. 
The rights granted herein are limited to the use rights of the Software and do not include any other rights. You own the media 
on which the Software is recorded but Niemeijer Consult and/or Niemeijer Consult’s licensor(s) retain ownership of the 
Software itself.

2. Evaluation copies. This license also applies in full for so-called demo or evaluation copies of the Software for which use 
is solely permitted for a period of a few days up to (in case explicitly stated) a maximum of 3 weeks before purchase. If the 
Software is not purchased within the stated period the Software should be removed permanently and completely from the 
computer(s) on which it has been installed. 

3. Permitted License Uses and Restrictions. This License allows you to install and use one copy of the Software on a single 
computer at a time. This License does not allow the Software to exist on more than one computer at a time except for home 
use by a single individual. It is not permitted to use the Software on more than one computer at a time or make the Software 
available over a network where it could be used by multiple computers at the same time. You may make one copy of the 
Software in machine-readable form for backup purposes only; provided that the backup copy must include all copyright or 
other proprietary notices contained on the original. Except as and only to the extent expressly permitted in this License or 
by applicable law, you may not copy, decompile, reverse engineer, disassemble, modify, or create derivative works of the 
Software or any part thereof. THE SOFTWARE IS NOT INTENDED FOR USE IN THE OPERATION OF NUCLEAR 
FACILITIES, AIRCRAFT NAVIGATION OR COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL SYSTEMS, 
LIFE SUPPORT MACHINES OR OTHER EQUIPMENT IN (OR, MORE IN GENERAL, CIRCUMSTANCES UNDER) 
WHICH THE FAILURE OF THE SOFTWARE COULD LEAD TO DEATH, PERSONAL INJURY, OR SEVERE 
PHYSICAL OR ENVIRONMENTAL DAMAGE.

Permitted License Uses and Restrictions regarding the Acapela Group Voices. This License allows you to Use the Acapela 
Group Software on a single hardware support and only make one copy of the Acapela Group Software in machine-readable 
form for backup purposes only. You must reproduce on such a copy the Acapela Group copyright notice and any other 
proprietary legends that were on the original copy of the Acapela Group Software. You may also transfer all your license 
rights in the Acapela Group Software, the backup copy of the Acapela Group Software, the related documentation, and a copy 
of this License to another party, provided the other party reads and agrees to accept the terms and conditions of this License. 
IMPORTANT: The term “Use”, used above, does not include the right to replicate sound files resulting from the Acapela 
Group Software for the purpose of reselling or re-distributing on a media (e.g. CD ROM, Disk) or via downloads; nor to 
broadcast or do public performance. Such specific uses are subject to a separate licensing agreement.

4. Transfer. You may not rent, lease, lend or sublicense the Software. You may, however, make a one-time permanent transfer 
of all of your license rights to the Software to another party, provided that: (a) the transfer must include all of the Software, 
including all its component parts, original media, printed materials and this License; (b) you do not retain any copies of 
the Software, full or partial, including copies stored on a computer or other storage device; and (c) the party receiving the 
Software reads and agrees to accept the terms and conditions of this License.

5. Termination. This License is effective until terminated. Your rights under this License will terminate automatically without 
notice from Niemeijer Consult or a Niemeijer Consult authorized representative if you fail to comply with any term(s) of this 
License. Upon the termination of this License, you shall cease all use of the Software and destroy all copies, full or partial, of 
the Software.

6. Limited Warranty on Media. Niemeijer Consult warrants the media on which the Software is recorded and delivered by 
Niemeijer Consult to be free from defects in materials and workmanship under normal use for a period of thirty (30) days 
from the date of original retail purchase. Your exclusive remedy under this Section shall be, at Niemeijer Consult’s option, 
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a refund of the purchase price of the Software or replacement of the Software, which is returned to Niemeijer Consult or a 
Niemeijer Consult authorized representative with a copy of the receipt. This limited warranty and any implied warranties on 
the media including, but not limited to, the implied warranties of merchantability, of satisfactory quality, and of fitness for 
a particular purpose, are limited in duration to thirty (30) days from the date of original retail purchase. Some jurisdictions 
do not allow limitations on how long an implied warranty lasts, so the above limitation may not apply to you. The limited 
warranty set forth herein is the only warranty made to you and is provided in lieu of any other warranties (if any) created by 
any documentation or packaging. This limited warranty gives you specific legal rights, and you may also have other rights, 
which vary by jurisdiction.

7. Disclaimer of Warranties. YOU EXPRESSLY ACKNOWLEDGE AND AGREE THAT USE OF THE SOFTWARE 
IS AT YOUR SOLE RISK AND THAT THE ENTIRE RISK AS TO SATISFACTORY QUALITY, PERFORMANCE, 
ACCURACY AND EFFORT IS WITH YOU. Except for the limited warranty on media set forth above and to the maximum 
extent permitted by applicable law, the Software is provided “as is”, with all faults and without warranty of any kind, and 
Niemeijer Consult and Niemeijer Consult’s licensors (collectively referred to as “Niemeijer Consult” for the purposes of 
sections 7 and 8) hereby disclaim all warranties and conditions with respect to the Software, either express, implied or 
statutory, including, but not limited to, the implied warranties and/or conditions of merchantability, of satisfactory quality, 
of fitness for a particular purpose, of accuracy, of quiet enjoyment, and non-infringement of third party rights. Niemeijer 
Consult does not warrant against interference with your enjoyment of the Software, that the functions contained in the 
Software will meet your requirements, that the operation of the Software will be uninterrupted or error-free, or that defects in 
the Software will be corrected. No oral or written information or advice given by Niemeijer Consult or a Niemeijer Consult 
authorized representative shall create a warranty. Should the Software prove defective, you assume the entire cost of all 
necessary servicing, repair or correction. Some jurisdictions do not allow the exclusion of implied warranties or limitations 
on applicable statutory rights of a consumer, so the above exclusion and limitations may not apply to you.

8. Limitation of Liability. TO THE EXTENT NOT PROHIBITED BY LAW, IN NO EVENT SHALL NIEMEIJER 
CONSULT BE LIABLE FOR PERSONAL INJURY, OR ANY INCIDENTAL, SPECIAL, INDIRECT OR 
CONSEQUENTIAL DAMAGES WHATSOEVER, INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF 
PROFITS, LOSS OF DATA, BUSINESS INTERRUPTION OR ANY OTHER COMMERCIAL DAMAGES OR LOSSES, 
ARISING OUT OF OR RELATED TO YOUR USE OR INABILITY TO USE THE SOFTWARE, HOWEVER CAUSED, 
REGARDLESS OF THE THEORY OF LIABILITY (CONTRACT, TORT OR OTHERWISE) AND EVEN IF NIEMEIJER 
CONSULT HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. Some jurisdictions do not allow the 
limitation of liability for personal injury, or of incidental or consequential damages, so this limitation may not apply to you. 
In no event shall Niemeijer Consult’s total liability to you for all damages (other than as may be required by applicable law in 
cases involving personal injury) exceed the amount of fifty euro (euro 50.00). The foregoing limitations will apply even if the 
above stated remedy fails of its essential purpose.

9. Controlling Law and Severability. This License is established in the Dutch language, which will be regarded as the 
authentic language for this License. Any translation of this License is done for local requirements. In the event of a dispute 
between the Dutch and any non-Dutch versions, the Dutch version of this License shall govern. The agreement that will be 
entered in will be governed exclusively by Dutch law and disputes shall be exclusively brought in front of Dutch judges and 
courts in the Netherlands, unless prevailing International Treaties enforce a different regulation. In those cases where the 
choice of forum (court or judge) is not up to Niemeijer Consult but to the user of the Software the user obliges himself/herself 
to select a Dutch judge in The Netherlands. If for any reason a court of competent jurisdiction finds any provision, or portion 
thereof, to be unenforceable, the remainder of this License shall continue in full force and effect.

10. Complete Agreement. This License constitutes the entire agreement between the parties with respect to the use of the 
Software licensed hereunder and supersedes all prior or contemporaneous understandings regarding such subject matter. No 
amendment to or modification of this License will be binding unless in writing and signed by Niemeijer Consult or Niemeijer 
Consult’s authorized representatives.
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Your Dealer:

Your Distributor:
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